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o Numerics ®

001 MP3 Encoder, 363
4-band EQ (Pro Tools), 313-314
16-bit option for mastering, 289-290
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A connection (USB), 105
Aardvark audio interfaces, 77
absorber/reflector, 44-45, 46
Absynth soft-synth (Native
Instruments), 266
ACID (Sony Media Software), 122, 134-135
acoustic instruments
equalizing, 319
microphone for, 185
Acoustica MP3 Audio Mixer, 363
acoustics, 43
active monitor
connecting, 111
description of, 31, 95
AD (analog to digital) converter, 13, 15, 66
ADAT (Alesis Digital Audio Tape) optical
connector, 103, 104
AES/EBU (Audio Engineering Society/
European Broadcasting Union) cable,
103, 104
AIFF (Audio Interchange File Format),
33, 274-275
Alesis Digital Audio Tape (ADAT) optical
connector, 103, 104
Algorithm setting (reverb plug-in), 329
Alienware (PC builder), 58
ambient miking, 179, 188
amp simulator, 177
amp-isolator box, 42, 43

analog connections
overview of, 97-98
quarter-inch plugs, 98-100
RCA, 100-101, 102
XLR, 100, 101
analog inputs, 66
analog outputs, 66-67
analog to digital (AD) converter, 13, 15, 66
Apple. See also Logic; Mac
Audio Units (AU) format, 259, 300
GarageBand, 10, 255-256, 362
Apple~System Preferences (Mac), 161
Arrange window (Logic Pro)
Port selector, 234, 235
track, creating, 196
arranger, description of, 20, 22
The Art of Digital Audio (John
Watkinson), 69
assigning soft-synth to track, 263
ATA/IDE drive and FireWire interface, 62
Atmosphere soft-synth (Spectrasonics), 266
Attack slider (Pro Tools)
compressor, 338, 339-340
expander, 345
gate, 342
limiter, 341
attenuating, 28
AU (Audio Units) format, 259, 300
Audacity editing program, 363
audio capabilities of software
editing, 117-119
recording, 116-117
track counts, 116
Audio Compositor, 364
audio data, editing, 224-226
Audio Engineering Society/European
Broadcasting Union (AES/EBU) cable,
103, 104
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audio instrument track, 194
Audio Interchange File Format (AIFF),
33, 274-275
audio interface
AD and DA converters, 13, 15, 66
choosing, 76, 78-79
components of, 13-14
configurations, 66-67
connecting, 108-110
controller-based, 74-75
description of, 10, 65
digital audio specifications, 67-69
direct box, 15-16
FireWire, 72-73
manufacturers of, 77-78
PCI, 14, 69-72
preamp, 16-17
setting up, 163-168
sound card and, 15
sound from guitar into, 177-178
sound from keyboard into, 178
sound from microphone into, 178-181
types of, 14-15, 69
USB port and, 14-15, 73-74
Audio MIDI Setup icon, 229
Audio MIDI Setup window, 229, 230
audio recording. See also MIDI track; room
for recording
automation data, 271-273
click track, creating, 206-209
first take, 212-213
listening to take, 213
overdubbing, 218
Pro Tools and, 131
punching in and out, 213-218
setting levels for, 202-203
soft-synth performance, 263-264
software for, 362
audio track, 194
Audio Units (AU) format, 259, 300
Audio=>Audio Hardware & Drivers
(Logic Pro), 169, 171, 172
audio-based loop, 250
audio-based loop track, creating, 251-252
Audiophile 2496 (M-Audio), 72
Audio=>Soundtrack Loop Utility=>Open
(Logic Pro), 256
AudioSuite=>Duplicate (Pro Tools), 224

Auto Latch mode, 271
Auto Off mode, 270
auto punching, 214-217
Auto Read mode, 270
Auto Touch mode, 270-271
Auto Write mode, 270
Autoload song (Logic Pro), 194
automating mix
benefits of, 124
Cubase and, 137
automation, enabling, 271-272
automation moves, recording and editing,
272-273
AutoPlay feature, disabling, 157-158
auto-tune, 30
aux or auxiliary input track, 194

ol e

B connection (USB), 105
backplate, 89, 90
backup vocal, equalizing, 318
balance and monitor mix, 205
balanced cord, 99-100
balancing levels, 287-288
bandwidth, 68
bass, electric

equalizing, 319

microphone for, 184

side-chain technique and, 347-348
bass (kick) drum

equalizing, 319-320

miking, 186-187

side-chain technique and, 347-348
bass traps, 48-50
Baxandall curve, 286
beat mapping, 123
bit depth, 67, 117
Blackwood, Brad, Web site of, 358
BladeEnc MP3 encoder, 363
bleed, 94
boosting frequencies, 317
Bounce dialog box

Logic, 277

Pro Tools, 274-275, 290, 291
Bounce feature, 273, 276
bounce procedure, description of, 267
break-out box, 14, 71
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Broadcast Wave, 117
budget
audio interface and, 76
software and, 128, 129
buffer settings, adjusting, 170-172, 353-354
buffer size, 19, 63
Building a PC For Dummies, 4th edition
(Mark Chambers), 57
building
emotion of song, 268
Windows PC, 57-58
burning CD master
for mass production, 293-295
overview of, 291-292
protecting rights, 295
sequencing songs, 292-293
bus, 305
bus track, 194
.bwav extension, 117
BWF (WAV) file, 274
Bypass button
effects-processor Plug-In window, 323
Logic Pro, 305
using, 356

oo

cable
low-Z, 100
MIDI, 102
USB, 107
video or digital audio, 103
cache buffer, 19, 63
Cakewalk software
description of, 138-139
Guitar Tracks Pro, 10, 138
SONAR, 139-141
cardioid microphone, 92
carving out frequencies, 26, 310
CD burner, 292
CD mastering
balancing levels, 287-288
description of, 33
dithering or truncating file, 289
final mix, 288
optimizing dynamics, 283-285
overview of, 267, 279
professional, hiring, 280-281

sample rate, setting, 290-291
session, setting up, 281-283
16-bit option, 289-290
steps in process of, 279-280
tonal balance, perfecting, 285-287
Web site resources for, 358
chain, audio, 67
Chambers, Mark, Building a PC For
Dummies, 4th edition, 57
Change Duration option (Pro Tools), 247
Change Velocity option (Pro Tools), 247
Channel EQ (Logic), 314
channel strip, 202, 203
character, description of, 17
chats, online, Web sites for, 357
chipset, 56, 63
choosing
audio interface, 76, 78-79
computer, 53-54
equalizer, 313-314
Mac, 62
microphone, 93
MIDI interface, 86-87
plug-in, 307
soft-synth, 266
software, 53, 78-79, 130
chorus effects processor, 29, 333
click track
creating, 206-207
enabling, 212
playing, 209-212
tempo, setting, 207-208
time signature, choosing, 208-209
Click/Countoff Options dialog box
(Logic Pro), 210, 211
clipping, 27
Clock Source option (Hardware Setup
dialog box), 166
combination drive, 64
component, definition of, 9
compression ratio, 284
compressor
description of, 27-28, 337
multiband, 126
optimizing dynamics and, 283-285
parameters, 337-338
transients and, 181
Compressor window (Pro Tools), 338
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computer. See also CPU; Mac;
Windows XP PC
audio interface and, 76
choosing, 53-54
connecting to, 107
dedicating to audio, 158, 160, 353
hard drive, 19
linking computers, 143, 146
maintaining system performance, 351-356
memory, 18
reducing sound from, 39-40
requirements for, 18
software compatibility and, 128
Windows PC, 54-58
computer-control surface, 21, 22
condenser microphone
acoustic instruments and, 185
description of, 89-90
for vocals, 182
configuring Windows XP operating system,
150-158
connecting programs, 123
connections
analog, 97-102
to computer, 107
digital, 102-104
FireWire, 106
hardware, 158-159
input device, 110-111
interface, 108-110
keyboard controller, 261-263
MIDI port and, 228
monitor, 111-112
USB, 105
consolidation of selection, 125
construction type microphone, 89
control surface, 61
Controller data option (Pro Tools), 270
controller-based interface, 74-75
controlling, 272
Cool Edit Pro software, 119
copying track data, 224-225
copyright, 295
cords, long runs of, 42
CPU
description of, 56
dual-CPU-equipped computer, 55
placing in another room, 107

reducing sound from, 39-40
speed of, 18
crashes, 354
creating task, 38
creativity, inspiring, 39
Crystal soft-synth, 365
Cubase (Steinberg)
description of, 10
strengths of, 136-137
versions of, 136
weaknesses of, 137-138
cutting frequencies, 317
cymbals, 188, 321

o e

DA (digital to analog) converter, 13, 15, 66
daisy chain, 228
DAW (Digital Audio Workstation), 151
deactivating unused tracks, 356
dead air, 42
Decay setting (Pro Tools)

expander, 345

gate, 343

reverb plug-in, 329
dedicating computer to audio, 158, 160, 353
delay effects processor, 29, 331-333
Delay Lama soft-synth, 365
Delay setting (delay plug-in), 331
deleting MIDI note, 244-245
Depth setting (delay plug-in), 332
designer cord, 99
de-static process, 107
Destructive Record mode, 217
Device option (Hardware Setup dialog

box), 166

diffuser, 47
Diffusion setting (reverb plug-in), 329
Digi 002 interface (Digidesign)

Clock Source options, 166

as FireWire interface, 73, 77

MIDI ports and, 102
Digidesign. See also Digi 002 interface;

Pro Tools

audio interface, 77

RTAS format, 260, 301

TDM format, 301

User’s Conference, 54, 57-58
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digital audio specifications
bit depth, 67, 117
sampling rate, 68-69, 116-117, 204
Digital Audio Wave (PC builder), 58
Digital Audio Workstation (DAW), 151
digital connection
AES/EBU, 103, 104
MIDI, 102-103
overview of, 102
S/PDIF, 103, 104
Digital Performer (MOTU), 10, 144-145
digital signal processor
description of, 20, 24-25
dynamic, 26-28
effects, 28-30
equalizers, 25-26
features of, 125
digital to analog (DA) converter, 13, 15, 66
Digital/Optical Input and Output option
(Hardware Setup dialog box), 167, 168
direct box, 11, 14, 15-16
direct memory access (DMA), enabling, 156
Direct Monitoring option, 204-205
Direct X (DX) format, 260, 301
Dirt Keeps the Funk (Primesounds) loop
library, 257
disabling AutoPlay feature, 157-158
Disc at Once mode, 294
disk/process buffer, 171-172
Display Properties dialog box, 151, 152, 155
Display=>Edit Window Shows=I/O View
(Pro Tools), 199, 233-234
Display=>Mix Window Shows =Inserts
(Pro Tools), 311
Display=>Transport Window Shows=MIDI
Controls (Pro Tools), 206, 207, 239
distant miking, 179
distraction, eliminating, 38
dithering, 126, 289
DMA (direct memory access), enabling, 156
drawing, 272
driver, preparing to install software, 150
drum machine, 84-85
drums
cymbals, 188, 321
equalizing, 319-321
gating, 343
hi-hat, 188, 320-321
kick (bass), 186-187, 319-320

room and, 186

snare, 187, 320

tom-tom, 187, 320

tuning, 185-186
dry signal, 324
dual-CPU-equipped computer, 55
dual-head AGP graphics card, 64
Duplicate dialog box (Pro Tools), 224
duplication

of CD-R, 359

of selection, 125
duration of note, changing, 245
dust, dealing with, 39
DX (Direct X) format, 260, 301
dynamic microphone

description of, 89, 90-91

vocals and, 182
dynamic range, 67, 335
dynamics, optimizing, 279, 283-285
dynamics processor

compressor, 27-28, 337-340

description of, 26-27, 335

expander, 28, 343-346

gate, 28, 341-343

as Insert effects, 335-336

limiter, 27-28, 340-341

oF o

ECHO audio interface, 77
Edirol audio interface, 77
Edit window (Pro Tools), 233-234
Edit>Clear (Pro Tools), 245
editing
audio data, 224-226
loop, 122, 255-256
MIDI data manually, 241-246
MIDI operations/functions, 246-247
nondestructive, 223-224
overview of, 219
region, 222-223
selecting audio to edit, 219-221
soft-synth sound, 265
software for, 362-363
editing capabilities of software
Cakewalk, 139
Cubase, 137
Digital Performer, 145
Logic, 143
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editing capabilities of software (continued)
Nuendo, 146
overview of, 117-119
Pro Tools, 131-132
SONAR and, 141
Edit=>Insert Silence (Pro Tools), 226
editor, description of, 20, 22-23
effects
adding, 268
Insert, 324-325
performing on loops, 123
routing, 324
Send, 326-328
vocals, adding to, 205
Effects dialog box, 155, 156
effects processor
chorus, 29, 333
delay, 29, 331-333
description of, 28-29, 323
flanger, 29-30
pitch correction, 30
reverb, 29, 328-330
efficient working environment, creating,
36-39
electric bass
equalizing, 319
microphone for, 184
side-chain technique and, 347-348
electric guitar
equalizing, 319
microphone for, 183-184
eliminating distraction, 38
eMac (Apple), 61
emotion of song, building, 268
E-Mu audio interface, 77
enabling
automation, 271-272
click track, 212
DMA (direct memory access), 156
MIDI device in Windows XP, 231-232
MIDI device on Mac, 229-231
recording, 200-202, 236
Energy Saver dialog box, 161
engineer, mastering, hiring, 280-281
engineering task, 38

Environment window (Logic Pro),
252, 253
equalization (EQ). See also equalizers
description of, 309
of drums, 319-321
frequency guidelines, 317
of guitar, 318-319
mastering and, 286-287
mixing and, 268, 316
multiband, 313
of percussion, 321
of piano, 321
plug-in, inserting in track, 311-312
of vocals, 318
equalizers. See also parametric equalizer
choosing, 313-314
description of, 25
graphic, 25
low-pass/high-pass, 311, 315-316
shelf, 25-26, 310, 315
Error Reporting dialog box, 153
error-detection software, 294
errors accessing hardware, 354
expander, 28, 343-346
Expander window (Pro Tools), 344
External Key button (Pro Tools), 344, 347
external keyboard
connecting, 110
feel of, 84
MIDI port and, 228
sound from, 178

ofFe

fader, 237
Feedback setting (delay plug-in), 332
figure-8 microphone, 92
file format

MP3, 33

recording and, 117
file management and SONAR, 141
File>Bounce (Pro Tools), 274
File>Bounce to Disk (Pro Tools), 276
Filew>New Session (Pro Tools), 192
File>New Track (Pro Tools), 195, 232



Filem>Song Settings>Recording Options
(Logic Pro), 240
filter, 311
FireWire connector, 106
FireWire interface
ATA/IDE drive and, 62
connecting, 109-110
description of, 72-73
FireWire port, audio interface through, 15
fish fillets plug-ins, 364
flanger effects processor, 29-30
Flatten Performance option (Pro Tools), 247
formats for plug-ins, 129, 300-301
4-band EQ (Pro Tools), 313-314
freeze function
effects plug-in and, 300
Logic and, 142, 300
SONAR and, 141
using, 354
frequency and equalization, 314-315
frequency spectrum
equalization and, 317
rolling off top or bottom end of, 25-26, 91
splitting, 284
Functions=>Track=>Create (Logic Pro),
196, 251
FXpansion wrapper, 301

oG o

gain, 314, 315
Gain slider (Pro Tools)
compressor, 338
delay plug-in, 331
limiter, 341
GarageBand (Apple)
description of, 10, 362
editing loop in, 255-256
gate, 28, 341-343
Gate window (Pro Tools), 342-343
Gear Acquisition Syndrome (GAS), 358
gear, essential, keeping handy, 38
gluing instruments together, 330
graphic equalizer, 25
graphics card, 56, 64

graphics, slow, 354

Index

Groove Quantize option (Pro Tools), 247

Groove setting (delay plug-in), 332
grunge, adding to track, 341
guitar
acoustic, microphone for, 185
connecting, 110-111
electric, microphone for, 183-184
equalizing, 318-319
sound from, getting great, 177-178
Guitar Tracks Pro (Cakewalk), 10, 138

o H o

Hammerfall (RME), 70
hard drive
cleaning, 351-352
keeping free of unnecessary
applications, 353
Mac, 59
multiple, organizing, 62-63
requirements for, 19
Windows PC, 55
hardware
compatibility of, 128-129
connecting, 158-159
Digital Performer and, 145
errors accessing, 354
interface, setting up, 163-168
preparing to install software, 150
Pro Tools and, 132, 133-134
settings, configuring, 169-172
Hardware Setup dialog box, 164, 166—
HD192 interface (MOTU), 72
headphones
description of, 94
as monitor, 30-31
quality of, 206
headroom, 340
heat, dealing with, 39
HF Cut setting (reverb plug-in), 330
high-pass equalizer, 311, 315-316
high-shelf equalizer, 310, 315
hi-hat, 188, 320-321
hiring mastering engineer, 280-281

168
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Hold setting (Pro Tools)
expander, 345
gate, 342-343
Home Recording For Musicians For Dummies
(Jeff Strong), 2, 179, 292
Home Studio 2 (Cakewalk), 138
host-based plug-in, 301, 302
host-based version, 131
hot-swapping, 107
hybrid preamp, 17
Hyper Edit window (Logic Pro), 242, 243

o]e
iBook (Apple), 61
IEEE 1394. See FireWire interface
iMac (Apple), 60
impedance level and direct box, 16
In port (MIDI), 228
increasing punch of track, 339
indie music resources, 360
input device
connecting, 110-111
description of, 10, 11
instrument, 11
microphone, 11-12
sound module and soft-synth, 12-13
Input Quantize option (Pro Tools), 247
input/output buffer, 170-171
inputs, monitoring, 203-206, 236-237
Insert effects, 324-325. See also dynamics
processor
Insert pop-up menu
Logic Pro, 304, 325, 336
Pro Tools, 325, 336
inserting
dynamics processor into track, 335-336
effects, 324-325
EQ plug-in into track, 311-312
MIDI program change, 244
plug-in into track, 303-305
soft-synth into track, 263
inserts, 124
installing. See also installing software
plug-in, 303
soft-synth, 260-261
installing software
hardware settings, configuring, 169-172
interface, setting up, 163-168

Mac, 160-163
preparation for, 149-150
Windows XP, configuring operating
system, 150-158
Windows XP, connecting hardware,
158-159
Windows XP, steps for, 159-160
instrument. See also specific instruments
connecting, 110
as input device, 11, 66
miking, 179-180
instrument cord, 99
intellectual property, 361
interface. See also audio interface; FireWire
interface
Cakewalk software and, 139
connections and, 108-110
controller-based, 74-75
Cubase and, 137
Digital Performer, 145
hardware, setting up, 163-168
keyboard controller, 74, 75, 261-263
MIDI, 81, 86-87
PCl-based, 14, 69-72, 108-109
USB, 14-15, 73-74, 110
internal bit depth, 117
International Standard Recording Code
(ISRC), 295
I/O section (Edit window, Pro Tools),
233-234
isolation booth, 42
isolation box, 40, 43
iTunes-LAME Encoder, 363

oo

Katz, Bob, Web site of, 358
Key HPF setting (Pro Tools), 345
key input (Pro Tools), 346
Key Listen button (Pro Tools), 344, 347
Key LPF setting (Pro Tools), 345
keyboard
connecting, 110
feel of, 84
MIDI port and, 228
sound from, getting great, 178
keyboard controller interface
connecting, 261-263
description of, 74, 75



kick (bass) drum

equalizing, 319-320

miking, 186-187

side-chain technique and, 347-348
Knee slider (Pro Tools), 338

o/ o

labeling CD, 294
latency
buffer settings and, 170
FireWire interface and, 72
low-latency monitoring, 165-166
managing, 204-205
PCl-based interface and, 70
sampling rate and, 68
USB port and, 14
USB-based interface and, 73
LCD monitor, 64
lead vocal, equalizing, 318
level for recording, setting, 202-203
levels, balancing, 287-288
limiter
description of, 28
multiband, 126
optimizing dynamics and, 283-285
using, 340-341
Limiter window (Pro Tools), 340-341
line insert, 181
linking computers
with Logic, 143
with Nuendo, 146
liquid cooling of computer, 40
listening to take, 213
Logic (Apple)
Arrange window, 222
assigning key, time signature, and tempo,
254-255
audio-based loop track, creating, 251-252
Auto punching, setting up, 215-216
Bounce feature, 277
buffer settings, adjusting, 171, 172
Channel EQ, 314
channel strip, 202, 203
click track, playing, 209-212
editing soft-synth sound, 265
editing windows, 241-242, 243
enabling automation, 271-272
features of, 118, 128

freeze function, 142, 300
hardware, setting up, 169-170
Insert pop-up menu, 325, 336
inserting plug-in into track, 304
inserting soft-synth into track, 263, 264
keyboard controller, connecting, 262-263
loop browser, 252, 253
loop, creating, 256-257
loop punching, 218
MIDI-based loop track, creating, 250-251
naming track, 198
overdubbing, 239-240
Peak Level display, 203
Plug-In window, 325
Record Enable button, 201, 236
routing input and output signals, 199-200
Send effects, 237-328
Send for plug-in, using, 305-306
setting inputs and outputs, 234-235
song file, creating, 194
starting recording, 213
Stop button, 212
strengths of, 142-143
tempo, setting, 207-208
tempo/time signature dialog box, 206-207
time signature, choosing, 208-209
track, creating, 196-197
track for soft-synth, creating, 261
versions of, 141-142
weaknesses of, 143-144
loop
assigning key, time signature, and tempo
for, 254-255
choosing, 252-254
creating, 256-257
description of, 10, 249-250
editing, 255-256
formats, 250
loop libraries, finding, 257-258
loop punching, 217-218
loop track, creating, 250-252
looping
ACID and, 135
description of, 121-123
SONAR and, 141
low latency, 165-166
Low Latency monitoring option, 204
Low Pass setting (reverb plug-in), 330
low-pass equalizer, 311, 315-316

Index 3 75
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low-shelf equalizer, 310, 315
low-Z cable, 100

LPF setting (delay plug-in), 331
Lynx Studio Technology, 77-78

ol o

Mac (Apple)
choosing, 62
configurations of, 60-61
enabling MIDI device on, 229-231
installing plug-ins, 303
installing software, 160-163
minimum requirements, 59
operating system, 59-60
0OS X, 160-162, 352
Windows PC compared to, 57
MachFive soft-synth (MOTU), 266
Mackie
Control, 21, 22
Spike-XD2, 74
maintaining system performance, 351-356
manual punching, 214
MAS format, 260, 301
mass, 42
master or master fader track, 194
mastering
balancing levels, 287-288
description of, 33
dithering or truncating file, 289
final mix, 288
optimizing dynamics, 283-285
overview of, 267, 279
professional, hiring, 280-281
sample rate, setting, 290-291
session, setting up, 281-283
16-bit option, 289-290
steps in process of, 279-280
tonal balance, perfecting, 285-287
Web site resources for, 358
mastering capabilities of software, 126
Matrix window (Logic Pro), 242
M-Audio
audio interface, 78
Audiophile 2496, 72
Oxygen8, 86, 87
Ozonic, 75

media
CD, 33
computer file, 33
mastering, 10
overview of, 32
memory
Mac, 59
requirements for, 18, 63
Windows PC, 55
metadata, 256
Metamorphosis (Spectrasonics) loop
library, 257
Meter setting (delay plug-in), 332
meters, making dance, 284
metronome function. See click track

Metronome Settings section (Song Settings

dialog box, Logic Pro), 209, 210
Mick Fleetwood: Total Drumming (Sony
Media Software) loop library, 258
microphone
for acoustic instruments, 185
choosing, 93
condenser, 89-90
connecting, 111
construction type, 89
description of, 11-12
for drum set, 185-189
dynamic, 90-91
for electric bass, 184
for electric guitar, 183-184
overhead, 321
polarity patterns, 92-93
preamp, 14, 16, 66
ribbon, 91-92
signal chain for, 176
sound from, getting great, 178-181
transients, dealing with, 180-181
for vocals, 181-183
MID Converter 3.3, 364
MIDI cable, 102
MIDI capabilities of software
ACID, 135
Cubase, 136-137
Digital Performer, 145
Logic, 142
Nuendo, 147
overview of, 120-121
Pro Tools, 133
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MIDI channel
description of, 228-229
enabling in Windows XP, 231-232
enabling on Mac, 229-231
MIDI controller
description of, 12, 81
MIDI port and, 228
types of, 88
MIDI file, 33
MIDI interface
choosing, 86-87
description of, 81
MIDI jack, 102, 103
MIDI Merge/Replace button, 239
MIDI (Musical Instrument Digital Interface)
computer-based system for, 81-88
description of, 24, 79-80, 227
MIDI Operations window (Pro Tools),
246-247
MIDI port, 228
MIDI sequencer, 20, 24, 81
MIDI software, 364
MIDI track
adding MIDI event to, 242-243
creating, 232-233
description of, 194
editing manually, 241-246
enabling recording for, 236
monitoring inputs, 236-237
overdubbing, 238-240
playing back, 238
Pro Tools automation options, 270
recording, 237-238
setting inputs, outputs, and channels,
233-235
MIDI-based loop, 250
MIDI-based loop track, creating, 250-251
MIDI-capable recording programs,
evaluating, 120-121
MIDI=>Click (Logic Pro), 212
MIDI=>Input Devices (Pro Tools), 231, 232
miking instrument, 179-180
Mix setting (delay plug-in), 331
mixer
description of, 20-22
external, using, 205
mixer controller, 75

mixing. See also equalization (EQ); mixing
in-the-box
automation features, 124, 137, 269
automation modes, 270-271
to external recorder, 277-278
goals of, 268-269
mastering and, 280
overview of, 267
Pro Tools automation options, 269-270
recording automation data, 271-273
reverb and, 330
side-chain technique, 346-348
software capabilities for, 124
sound control during, 45-50
mixing in-the-box
bounce options, 274-276
overview of, 273
modulation, 333
monitor. See also near-field monitor
connecting, 111-112
description of, 10, 30, 93-94
headphones, 30-31
placement of, 37
speakers, 31-32, 94-95
video, 64
monitor mix, 205-206
monitoring inputs, 203-206, 236-237
Mono (Summed) format, 275
motherboard, 56
MOTU
audio interface, 78
Clock Source options, 166
Digital Performer, 10, 144-145
FireWire Audio dialog box, 165, 166, 168
HD192 interface, 72
MachFive soft-synth, 266
MAS format, 260, 301
mousing, 272
MP3 file format, 33
MP3 programs, 363
multiband compressor, 126
multiband EQ, 313
Multiple Mono format, 275
multitimbrality, 84
Music Creator Pro (Cakewalk), 138
Musical Instrument Digital Interface
cable, 102
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Musical Instrument Digital Interface channel
description of, 228-229
enabling in Windows XP, 231-232
enabling on Mac, 229-231
Musical Instrument Digital Interface
controller
description of, 12, 81
MIDI port and, 228
types of, 88
Musical Instrument Digital Interface file, 33
Musical Instrument Digital Interface
interface
choosing, 86-87
description of, 81
Musical Instrument Digital Interface jack,
102, 103
Musical Instrument Digital Interface (MIDI)
computer-based system for, 81-88
description of, 24, 79-80, 227
Musical Instrument Digital Interface
port, 228
Musical Instrument Digital Interface
sequencer, 20, 24, 81
Musical Instrument Digital Interface
software, 364
musical style
audio interface and, 76
dynamics and, 283
software and, 128
musicians, indie, finding, 360
MusicXPC (PC builder), 58
Mute option (Pro Tools), 269, 270

o\ o

Name the Track dialog box (Pro Tools), 198
naming track, 197-198
native plug-in, 302
near-field monitor
description of, 31
placement of, 37
sound control and, 45
types of, 94
New Session dialog box (Pro Tools),
192-193
New Track dialog box (Pro Tools),
195-196, 232-233

Newr>Audio Object (Logic Pro), 252
nondestructive editing, 223-224
non-destructive record mode, 217
normalizing track, 299

n-Track Studio recording program, 362
Nuendo (Steinberg), 146-147

Nyquist frequency, 68
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offline bouncing, 124
offline processing, 300, 306-307
omnidirectional microphone, 92
online forums, 357
operating system. See also Windows XP PC
Mac, 59-60, 160-162
Windows PC, 55, 150-158
optical drive
description of, 64
Mac, 59
Windows PC, 55
optimizing dynamics, 279, 283-285
organizing work space, 37
0S X (Mac)
installing software with, 160-162
reformatting audio drive, 352
Out port (MIDI]), 228
output track, 194
over, digital, 180
overdubbing, 218, 238-240
overhead microphone, 188, 321
overhead panel, 47
Oxygen8 (M-Audio), 86, 87
Ozonic (M-Audio), 75

oo

Pan option (Pro Tools), 269, 270
panel
absorber/reflector, 44-45, 46
overhead, 47
panning, stereo, 268
parametric equalizer
benefits of, 317
description of, 26, 27, 126, 286, 310
settings, 314-315
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passive monitor
connecting, 112
description of, 31-32, 95
PC. See also Windows PC; Windows XP PC
internal components of, 56
Mac compared to, 57
minimum requirements, 54-55
operating system, 55
setting up, 57-58
PC builder, MusicXPC, 58
PCI (Peripheral Component Interface) card,
13, 66
PCl-based interface
connecting, 108-109
description of, 14, 69-72
Pencil tool (Pro Tools), 225, 242-244
percussion, equalizing, 321. See also drums
performance, tips for maintaining, 351-356
Peripheral Component Interface (PCI)
card, 13
Peripherals list box (Hardware Setup
dialog box), 164, 166
phono plug, 100-101, 102
piano, equalizing, 321
pitch correction, 30
pitch of note, changing, 245
pitch shifting, 125
placement of microphone
for acoustic instruments, 185
for drums, 186-189
for electric bass, 184
for electric guitar, 183-184
techniques for, 179-180
for vocals, 182
placement of monitor, 37
planning for future, 129-130
Play button, 213, 238
playback buffer, 171-172
playing back
MIDI track, 238
recorded track, 264
plosives, 182
plug-in delay compensation
Pro Tools and, 133
SONAR and, 141
Plug-in parameters option (Pro Tools), 269

Plug-In window
Logic Pro, 304, 305, 325
Pro Tools, 325
plug-ins. See also dynamics processor;
effects; equalizers
choosing, 307
delay, 331-333
description of, 299
formats, 129, 300-301
host-based, 302
inserting into track, 303-305
installing, 260-261, 303
native, 302
offline processing and, 306-307
processing tracks with, 300
resources for, 363-364
reverb, 328-330
Send function and, 305-306
Pohlmann, Ken, Principles of Digital
Audio, 69
polarity patterns, 92-93
polyphony, 83
pop filter, 182
post-fader, 324
Power Mac (Apple), 60, 61
Power MP3 Cutter, 363
Power Options Properties dialog box, 154
PowerBook (Apple), 61
powered monitor, connecting, 111-112.
See also active monitor
PQ subcode, 292, 294
preamp
hybrid, 17
microphone, 14, 16, 66
solid-state, 16-17
tube, 17
preamp/interface in signal chain, 176
Predelay setting (reverb plug-in), 329
pre-fader, 324
Preferences dialog box
Logic Pro, 169, 170
Pro Tools, 290
pre-roll, creating, 216-217
Primesounds Dirt Keeps the Funk loop
library, 257
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Principles of Digital Audio (Ken
Pohlmann), 69

Pro Tools (Digidesign)
Arrange window, 222
Auto punching, setting up, 214-215
balancing levels, 287-288
Bounce feature, 274-275, 276
buffer settings, adjusting, 171, 172
channel strip, 202, 203
compressor plug-in, 337-338
copying track data, 224-225
deactivating unused tracks, 356
delay plug-in, 331-333
deleting MIDI note, 244-245
description of, 130-131
duration of note, changing, 245
editing regions, 222-223
enabling MIDI channel, 231, 232
expander plug-in, 344-345
features of, 117-119
4-band EQ, 313-314
gate plug-in, 342-343
hardware and, 128-129
Insert pop-up menu, 325, 336
inserting EQ plug-in into track, 311-312
inserting MIDI program change, 244
inserting soft-synth into track, 263, 264
key input, 346-348
limiter plug-in, 340-341
loop punching, 218
mastering session, creating, 281-283
MIDI event, adding, 242-244
MIDI Merge, 239
MIDI Operations window, 246-247
mixing automation options, 269-270
monitoring MIDI inputs, 237
naming track, 197-198
offline processing, 307
Parametric Equalizer icon, 310
Pencil tool, 225, 242-244
performing punch, 217
pitch of note, changing, 245
Plug-In window, 325
pre-roll, creating, 216
Record Enable button, 201, 236

redrawing waveform, 225-226
reverb plug-in, 328-330

routing input and output signals, 198-199

sample rate conversion process, 290

Scrub tool, 225

selecting on the fly, 220-221

Selector tool, 226

Send effects, 326-327

setting inputs, outputs, and channels,
233-234

silencing section of track, 226

song file, creating, 192-193

starting recording, 213

strengths of, 131-132

Tab to Transients function, 221

TDM format, 301

tempo, setting, 207

tempo/time signature dialog box, 206, 207

time location, changing, 246
time signature, choosing, 208
track, creating, 195-196, 232-233
track, selecting, 220
velocity of note, changing, 245-246
versions of, 131
weaknesses of, 133-134
Zero Return button, 212
Zoomer tool, 225
processor (computer)
Mac, 59
Windows PC, 54
processor (software). See digital signal
processor; dynamics processor;
effects processor
producing task, 38
Propellerhead, ReBirth soft-synth, 266
protecting rights, 295
proximity effect, 182
PSP Audioware plug-ins, 307
punching in and out
auto punching, 214-217
description of, 213-214
loop punching, 217-218
manual punching, 214
MIDI track, 241
performing punch, 217
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Q setting, 310, 315
quality of sound
synthesizer and, 84
volume and, 285
quantization, 120, 125
Quantize option (Pro Tools), 247
quantizing loops, 123
quarter-inch analog plug
TRS, 99-100
TS, 98-99
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rack-mountable sound module, 12-13
Range setting (Pro Tools)
expander, 345
gate, 343
Rate setting (delay plug-in), 332
Ratio setting (Pro Tools)
compressor, 338
expander, 345
RCA plug, 100-101, 102
real-time processing, 300
ReBirth soft-synth (Propellerhead), 266
rebooting computer, 150
Record Enable button, 236
record-enabling
audio track, 200-202
MIDI track, 236
recording. See also MIDI track; room for
recording
automation data, 271-273
click track, creating, 206-209
first take, 212-213
listening to take, 213
overdubbing, 218
Pro Tools and, 131
punching in and out, 213-218
setting levels for, 202-203
soft-synth performance, 263-264
software for, 362
recording capabilities of software
bit depth, 117
file format, 117

Pro Tools, 131
sample rate, 116-117
recording studio, components of, 9-10
Red Book CD, 292
redrawing waveform, 225-226
reducing sound from computer, 39-40
reflection, 42, 46
reformatting audio drive, 352-353
region
description of, 219
editing, 222-224
Release slider (Pro Tools)
compressor, 338, 339-340
limiter, 341
replication, 359
Restore Performance option
(Pro Tools), 247
reverb effects processor, 29, 328-330
ReWire program, 123
ribbon microphone
description of, 89, 91-92
for vocals, 182
RME
audio interface, 78
Hammerfall, 70
rolling off top or bottom end of frequency
spectrum, 25-26, 91
room effect, 328
room for recording
dealing with sound in, 42-50
efficient working environment, creating,
36-39
heat and dust, taming, 39
keeping sound in or out of, 41-42
optimizing sound in, 40-41
preparing, 35-36
room modes, 43
RoomMachine 844 plug-in, 364
rotational speed, 19, 62
rounding error, 68
routing
effects, 324
input and output signals, 198-200
RTAS format, 260, 301
RubyTube plug-in, 364
rumble, 26
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sample rate
description of, 68-69, 116-117
latency and, 204
setting, 290-291
sample rate conversion process, 290-291
Sample Rate drop-down list (Hardware
Setup dialog box), 167, 168
sampler, 85-86
sampling rate. See sample rate
Sayers, John, Web site of, 359
Score window (Logic Pro), 242, 243
scoring, 120
screen saver, disabling, 154-155
Scrub feature, 118, 119
Scrub tool (Pro Tools), 225
seek time, 19, 63
Select Notes option (Pro Tools), 247
selecting
audio to edit, 219-220
entire track, 220
on the fly, 220-221
loop, 252-254
Tab to Transients function (Pro Tools),
using, 221
Selector tool (Pro Tools), 226
Send effects, 124, 326-328
Send function, 305-306
Send option (Pro Tools), 269
Send Output window (Pro Tools), 326
sequencer, built-in, 84, 88
sequencing
burning CD and, 292-293
mastering and, 279-280
multitimbral synth and, 84
Setups=>Hardware Setup (Mac), 164
Setups=>Playback Engine (Pro Tools),
171,172
Setups=Preferences (Pro Tools), 290
Shareware Music Machine Web site, 362
shelf equalizer
description of, 25-26, 310
using, 315
Shuffle editing mode, 118
Shure, SM57 and SM58, 90
sibilants, 182
side-chain, 346-348

signal chain, 175-176
signal processor, 323
Signature/Key Change List Editor window
(Logic Pro), 254
silencing section of track, 226
SimulAnalog Guitar Suite plug-in, 364
16-bit option for mastering, 289-290
Size setting (reverb plug-in), 329
slap-back echo, 333
SM57 and SM58 (Shure), 90
smoothing out track, 340
snare drum, 187, 320
soft-synth
assigning to track, 263
choosing, 266
description of, 13, 82, 259
Digital Performer and, 145
editing sound, 265
formats for, 259-260
installing, 260-261
keyboard controller, connecting, 261-263
Logic and, 142
recording performance, 263-264
resources for, 365
sound from, getting great, 178
track for, creating, 261
software. See also installing software;
Logic; Pro Tools; soft-synth
ACID (Sony Media Software), 122, 134-135
arranger, 22
audio capabilities of, 116-119
Cakewalk, 138-139
CD burner, 292
choosing, 53, 78-79, 130
compatibility of, 129
cracked copies of, 361
Cubase (Steinberg), 10, 136-138
description of, 10, 19-20
Digital Performer (MOTU), 10, 144-145
digital signal processor, 24-30, 125
editing, 362-363
editor, 22-23
error-detection, 294
looping capabilities of, 121-123, 249
mastering capabilities of, 126
MIDI, 364
MIDI capabilities of, 120-121, 227
MIDI sequencer, 24
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mixer, 20-22
mixing capabilities, 124
MP3, 363
multiple programs, using, 127
needs, identifying, 128-130
Nuendo (Steinberg), 146-147
overview of, 115
recording, 362
in signal chain, 176
SONAR (Cakewalk), 139-141
synchronizing, 123
trying before buying, 130
upgrading, 129-130
Software monitoring option, 204
software synthesizer. See soft-synth
Software Update dialog box, 162
solid-state preamp, 16-17
Sonalksis plug-ins, 307
SONAR (Cakewalk), 139-141
song file
assigning key, time signature, and tempo,
254-255
creating, 192-194
input and output signals, 198-200
tracks, working with, 194-198
Song Settings dialog box (Logic Pro),
209, 210, 240
Sony Media Software
ACID, 122, 134-135
Mick Fleetwood: Total Drumming loop
library, 258
Sony/Phillips Digital Interface Format
(S/PDIF) connector, 103, 104
sound
controlling during mixing, 45-50
controlling during tracking, 44-45
controlling in room, 42-44
from guitar, 177-178
keeping in or out of recording room, 41-42
from keyboard, 178
from microphone, 178-181
signal chain and, 175-176
sound card
description of, 13, 15, 66
PCl-based, 70-72
sound generator
description of, 81
drum machine, 84-85

sampler, 85-86
soft-synth, 82
sound module, 85
synthesizer, 83-84
sound module, 12-13, 85
soundhack editing program, 363
Sounds and Audio Devices Properties
dialog box, 156
Soundtrack Loop Utility window
(Logic Pro), 256, 257
source in signal chain, 176
S/PDIF (Sony/Phillips Digital Interface
Format) connector, 103, 104
speaker cord, 98-99
speakers
home stereo, 112
as monitor, 31-32, 94-95
spectral analyzer, 287
Spectrasonics
Atmosphere soft-synth, 266
Metamorphosis loop library, 257
Spike-XD2 (Mackie), 74
spindle speed, 19, 62
Split Notes option (Pro Tools), 247
Spot feature, 118
spot miking, 179
standby power, 154
standing waves, 48
Start=>Settings=>Control Panel (XP), 151
starved-plate preamp, 17
Steinberg
Cubase, 10, 136-138
Nuendo, 146-147
VST format, 260, 301
Stereo Interleaved format, 275-276
stereo miking, 180
Strong, Jeff, Home Recording For Musicians
For Dummies, 2, 179, 292
studio
commercial, compatibility with, 132-133
components of, 9-10
support for setting up, 358-359
submixing, 255
surround mixing
description of, 124
Nuendo and, 146
synchronizing software, 123
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synthesizer. See also soft-synth
description of, 83-84
MIDI port and, 228
System Preferences dialog box, 161
System Properties dialog box, 153
system sound, disabling, 156
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Tab to Transient feature, 118, 119
take, listening to, 213
TASCAM audio interface, 78
TC Powercore, 302
TDM format, 301
Tempo Match setting (delay plug-in),
332, 333
tempo, setting for click track, 207-208
Tempo/Signature Display (Logic Pro),
206-207
threshold, 28
Threshold setting (Pro Tools)
compressor, 338, 339
expander, 344
gate, 342
limiter, 341
Thru port (MID]), 228
time location, changing, 246
time, placing between songs on CD, 293
time signature, choosing for click track,
208-209
Tip/Ring/Sleeve (TRS) plug, 99-100, 101
Tip/Sleeve (TS) plug, 98-99
tom-tom, 187, 320
tonal balance, 279, 285-287
tonal clarity, 268
Toslink connector, 103, 104
track count
description of, 116
hard drive speed and, 19
minimizing, 355
Pro Tools and, 133
tracking, sound control during, 44-45
tracks. See also click track; MIDI track
assigning soft-synth to, 263
cleaning up, 355-356
creating, 195-197
dynamics processor, inserting into,
335-336

enabling recording in, 200-202
EQ plug-in, inserting into, 311-312
equalizing when mixing, 316
naming, 197-198
normalizing, 299
plug-in, inserting into, 303-305
real-time processing, 300
selecting to edit, 220
silencing section of, 226
for soft-synth, creating, 261
turning off unused, 356
types of, 194-195
Tracktion recording program, 362
transient
compressor and, 337
description of, 27, 180-181
Transport window, 206
Transpose option (Pro Tools), 247
transposition, 120, 125
troubleshooting
performance issues, 354
record-enabling, 201-202
TRS (Tip/Ring/Sleeve) plug, 99-100, 101
truncating file, 289
trying software before buying, 130
TS (Tip/Sleeve) plug, 98-99
tube preamp, 17
tuning drums, 185-186
turning off computer, 107
tweaking, 284
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unbalanced line, 99

Universal Audio UAD 1, 302

unpowered monitor
connecting, 112
description of, 31-32, 95

updating system software before installing

audio program, 149
upgrading software, 129-130
USB cable, 107
USB connection, 105
USB interface, connecting, 110
USB port, audio interface through,
14-15, 73-74
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velocity of note, changing, 245-246
video monitor, 64
virus protection, disabling, 158
vocals
adding effects to, 205
breath from singer, dealing with, 344, 346
equalizing, 318
making room for in dense mix, 347
microphone for, 181-183
reverb and, 330
slap-back echo and, 333
voice coil, 90
volume
low, and mixing, 45
quality of sound and, 285
of songs, matching, 279
volume balance, 268
Volume option (Pro Tools), 269, 270
Voxengo plug-ins, 307
VST format, 260, 301
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Watkinson, John, The Art of Digital Audio, 69
.wav extension, 117
WAV file, 33
waveform, redrawing, 225-226
WaveLab software, 119
Waves Audio Ltd. plug-ins, 307
Web sites
ACID, 135
audio interface manufacturers, 77-78
author, 40
Cakewalk, 139
copyright, 295
Cubase, 138
Digidesign User’s Conference, 54
Digital Performer, 145
duplication, 359
editing software, 363
FXpansion wrapper, 301
gear, 358
indie music, 360
Logic, 144
loop libraries, 257-258

mastering, 358
mastering professionals, 280
MIDI software, 364
MP3 software, 363
musicians, indie, 360
Nuendo, 147
online forums, 357
PC builders, 58
plug-ins, 307, 363-364
Pro Tools, 134
recording software, 362
replication, 359
ReWire program, 123
room modes, 43
Shareware Music Machine, 362
soft-synths, 266, 365
SONAR, 141
support for setting up studio, 358-359
TC Powercore, 302
Universal Audio UAD 1, 302
wet signal, 324
windows, multiple, 120, 121
Windows PC. See also Windows XP PC
Direct X (DX) format, 260, 301
internal components of, 56
Mac compared to, 57
minimum requirements, 54-55
operating system, 55
setting up, 57-58
Windows XP PC
AutoPlay, disabling, 157-158
Classic mode, 151-152
configuring operating system, 150-158
Control Panel settings, 153
DMA, enabling, 156
enabling MIDI channel on, 231-232
hardware, connecting, 158-159
installing plug-ins, 303
reformatting audio drive, 352
settings, 151
software, installing, 159-160
virus protection, disabling, 158
Windows=Open Transport (Logic Pro), 206
Windows=>Show Tempo/Meter
(Pro Tools), 207
Windows=>Show Transport (Pro Tools), 206
Winer, Ethan, Web site of, 359
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working environment, efficient,
creating, 36-39

workstation, setting up, 36-37

wrapper, 301

Write Disk mode, 294
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XLR connector, 100, 101

oyo

Y cord, 99, 100, 101
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001 MP3 Encoder, 363
Zoomer tool (Pro Tools), 225



